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Agenda

Presentation will introduce software constructs 

and concepts: 

⚫ Arduino®/chipKIT®: What are they?

⚫ Arduino IDE quick start

⚫ Demo #1: Get blinky lights working

⚫ Demo #2: Built in Serial I/O

⚫ Using libraries 

⚫ How to debug a sketch with MPLAB® X 

Integrated Development Environment (IDE)
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Arduino®/chipKIT®:
What are they?

⚫ Both are rapid prototyping platforms

⚫ Compatible with each other at source 

code and physical interface level

⚫ Fills need for beginners to quickly 

construct simple microcontroller-based 

designs (and many more)
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Arduino Beginnings

“Arduino is an open-source electronics 

prototyping platform based on flexible, 

easy-to-use hardware and software. It's 

intended for artists, designers, 

hobbyists, and anyone interested in 

creating interactive objects or 

environments.”
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What is Arduino Now?

⚫ An environment for learning embedded 

systems

⚫ A huge ecosystem

⚫ Boards and extension shields

⚫ Thousands of libraries

⚫ Projects, web pages, videos

⚫ IDEs (PC and web-based)

⚫ Learning tool for most beginners

⚫ THE de facto embedded teaching tool
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Arduino Vocabulary

⚫ Sketch

⚫ Source code/program in C/C++

⚫ Shield

⚫ An add-on board to extend functionality

⚫ Standard pinout – function and layout

⚫ Hardware Abstraction Layer 

⚫ Eliminates need to know hardware details

⚫ Refers to pins in a standard way
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chipKIT Platform Project 
Goals

⚫ Start with Arduino compatibility

⚫ Use powerful 32-bit PIC32 processors

⚫ Remain open and inviting to all developers who 

want to contribute – hardware or software

⚫ Continue to improve core Arduino libraries to be 

higher quality, more feature rich 

⚫ Create variety of board offerings - some with 

physical Arduino compatibility - all easy to use

⚫ Continue to add high-performance libraries for 

PIC32 peripherals
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chipKIT Platform Core 
Software

⚫ Includes:
⚫ Compiler tool chain

⚫ Standard Arduino libraries

⚫ Contributed libraries (e.g., SoftPWMServo, DSPI)

⚫ A modular distribution:

⚫ For use in many different IDEs

⚫ Provides hardware abstraction benefits
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Demo #1
Blink that LED
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Demo #1 
Objective/Procedure

Demonstrate how simple it is to use the 

Arduino IDE by writing, compiling and 

uploading LED blink code into the chipKIT

development board.

⚫ Open Arduino IDE

⚫ Write code

⚫ Select proper development board target

⚫ Put chipKIT board into bootloader mode

⚫ Compile, upload, and run
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Arduino IDE

⚫ Open Arduino IDE from desktop

VERIFY

OPENNEWUPLOAD SAVE

SKETCH

AREA

OUTPUT

WINDOW

SERIAL MONITOR

CURRENT HW SETUP

(board and serial port)
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Add some code

⚫ Select File -> New

⚫ Make your source code look like this:

void setup() {

pinMode(LED_BUILTIN, OUTPUT);

}

void loop() {

digitalWrite(LED_BUILTIN, HIGH);

delay(1000);

digitalWrite(LED_BUILTIN, LOW);

delay(1000);

}
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Prepare for the Upload

⚫ Select Tools -> Board -> Fubarino® Mini

⚫ Activate the bootloader

⚫ Press and hold PRG (program) button while 

pressing and releasing RESET

⚫ Should see fast blinking green LED = 

bootloader mode active

Reset Button

PRG Button

USB

for

Serial

chipKIT™ Fubarino Mini
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⚫ Click the Upload button

⚫ Arduino IDE will compile your sketch

⚫ Arduino IDE will upload the sketch

⚫ Confirm that your green LED is blinking 

1000 ms on, 1000 ms off

Compile, Program and Run
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Basic Sketch

⚫ An Arduino program is called a 

sketch

⚫ Language used is C++

⚫ Embedded program event loop is 

built into the system

⚫ Two required functions

⚫ setup()– one time initialization

⚫ loop()– called repeatedly by system
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Writing the Sketch

⚫ Every sketch must include:
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Compiling

⚫ The sketch needs to be converted into a 
form that can be executed on the board

⚫ After writing the sketch:

⚫ The user presses the upload button

⚫ The sketch is compiled and a hex file is 
created

⚫ The hex file is uploaded to dev board using 
command-line program pic32prog

⚫ Any compile or upload errors are reported 
in the IDE output window
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Bootloader

⚫ All chipKIT boards come pre-programmed 
with a bootloader

⚫ Arduino IDE uses this bootloader to 
upload (program) the hex file to the board

⚫ Replaces the need for a hardware 
programmer

⚫ There are two basic kinds of chipKIT
boards:

⚫ Automatic reset through on-board FTDI 
chip

⚫ Manual reset via PROGRAM button
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Code – Blink LED
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Summary

⚫ Experience ArduinoIDE workflow

⚫ Enter new sketch

⚫ Compile and upload to chipKIT® board

⚫ Basic code template

⚫ Basic Arduino Hardware Abstraction 

Library (HAL) concepts

⚫ Set pin as output

⚫ Set output pin state

⚫ Create time delay
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Why Use chipKIT Platform?

⚫ A PIC32-based, open-source software 
and hardware platform

⚫Compatible with Arduino code and 
add-on boards

⚫ Software tools to build, load and run 
Arduino sketches 

⚫ A diverse community of contributors, 
developers, and users

⚫More than just Digilent or Microchip
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Some chipKIT Boards

uC32
Wi-FIRE

Fubarino® Mini Lenny
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chipKIT Shields

Basic I/O Shield Wi-Fi® Shield

Quick IO Shield High Precision DAQ Shield
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An enormous number of 
Arduino shields are suitable 
for use with chipKIT® boards, 
but you must mind your 
voltage levels.

Ethernet Shield

Graphic Display 

Shield

Motor Drive Shield

Some Arduino® Shields
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Arduino® and ChipKIT®

Software Environment
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Software Architecture

Arduino® IDE

USB

chipKIT® board

Internet chipKIT® 

platform core

sketch

pic32prog

chipKIT

compiler

chipKIT

libraries

board

definitions
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chipKIT® Platform Core 
Software

⚫ Major components

⚫ Compiler tool chain

⚫ Standard Arduino® libraries

⚫ Contributed libraries (e.g. 

SoftPWMServo, DSPI)

⚫ A modular distribution

⚫ For use in many different IDEs

⚫ Provides hardware abstraction benefits
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HAL Pins chipKIT®

Hardware -> PIC32

⚫ Every pin is given a ‘chipKIT’ number

⚫ This is the only number needed in the code

⚫ No need to worry about port or PIC32 pin

chipKIT Pin PIC32 Pin Port/Pin Function

26 1 RB9 RPB9/SDA1/CTED4/PMD3/RB9
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Supported Toolchains

⚫ Arduino® IDE

⚫ Supports many third-party plug-ins, including chipKIT® technology core

⚫ UECIDE

⚫ Similar to Arduino IDE, but substantially rewritten and improved, 
supports chipKIT technology core

⚫ MPIDE

⚫ An early fork of Arduino IDE, w/ chipKIT technology core built-in

⚫ Archived in August 2015

⚫ Other Sketch-Enabled Environments

⚫ EmbedXcode, Visual Micro, PlatformIO, etc.

⚫ MPLAB® X IDE

⚫ NetBeans-based professional IDE (Win, Mac, Linux)

⚫ Supports chipKIT hardware; sketch support (see advanced class)
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MPLAB® Harmony
vs. chipKIT® Platform

⚫ All chipKIT boards can be used directly 

with MPLAB X IDE and MPLAB

Harmony Framework

⚫ MPLAB X IDE and XC32 C/C++

⚫ MPLAB programmer and debugger tools

⚫ Note: MPLAB Harmony and chipKIT 

development environments are 

completely different

⚫ Source code is not directly compatible
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Programming

Concepts
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Programming Model

Remember: The sketch implements two 

required functions
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Programming Model

Core library adds this code behind the scenes 
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Core Runtime Functions

pinMode(pin, dir)

⚫ Sets pin direction and drive type

digitalRead(pin)

⚫ Reads the state of a digital pin

digitalWrite(pin, val)

⚫ Sets a digital pin to specified state

delay(ms)

⚫ Delay for specified number of milliseconds
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Example: 
How to Dim an LED
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Hardware Serial

Serial.begin(baud)

⚫ Initialize the UART and set the baud 
rate

Serial.print(val)

⚫ Print the specified value to UART

Serial.read()

⚫ Read characters from UART
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Demo #2:
Serial Monitor
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Activity

Send serial data output from chipKIT® board 

back to PC over USB, then view using the 

Arduino® IDE Serial Monitor

⚫ helloserial sketch
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Code – Hello World
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Summary

⚫ Display text output to PC over USB 

using Arduino® IDE Serial Monitor
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Using Libraries
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Adding Libraries

⚫ Use built-in Library Manager to search 

for and install extra libraries

⚫ Some libraries are not available in 

Library Manager; instead download zip 

file from GitHub repo or website

⚫ Adafruit DotStar Library: We will use 

this one to control our LED strip
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Using Libraries

⚫ Pre-written libraries provide additional 

functionality

⚫ If you add hardware to your design, 

there are often libraries available to 

help make use of the hardware

⚫ Use to add a 

library to your sketch

⚫ chipKIT® technology core includes 

highly optimized libraries for PIC32
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Example: Library Manager

Adafruit DotStar Library
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How to Debug a Sketch 
with MPLAB® X

⚫ Introduction to chipKIT® sketch 

importer for MPLAB X IDE

⚫ Importing a sketch into MPLAB X IDE

⚫ Uploading

⚫ Debugging
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chipKIT® Sketch Importer

⚫ Takes existing sketches from Arduino®

IDE

⚫ Creates MPLAB® X IDE project, 

includes all code

⚫ ‘default’ configuration – serial 

bootloading

⚫ ‘debug’ configuration – hardware 

debugging
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Importing chipKIT®

Sketches

⚫ The plugin installs an Import Wizard 

under the File menu
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Importing chipKIT®

Sketches

⚫ Specify sketch, Arduino® directory, and target board
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Build/Debug in MPLAB® X 
IDE
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Debugging/Breakpoints
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Further Information

⚫ The chipKIT® platform advanced class 

contains complete information on how to 

install and use the chipKIT importer 

plugin, along with many other advanced 

topics
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Summary

⚫ Provided overview of chipKIT® platform 
and how it relates to Arduino®

⚫ Learned how to write, compile, load and 
execute sketches

⚫ Explored basic I/O operations, including 
digital, analog, serial and LED animation

⚫ Examined debugging sketch from within 
MPLAB® X IDE

⚫ Experienced wonder and excitement at 
PIC32 power coupled with Arduino ease 
of use
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Appendix
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Resources

⚫ chipKIT® Platform web site

http://chipkit.net

http://chipkit.net/wiki

http://chipkit.net/forum

⚫ Fubarino® Site

http://fubarino.org

⚫ Arduino®

https://www.arduino.cc/

http://chipkit.net/
http://chipkit.net/wiki
http://chipkit.net/forum
http://fubarino.org/
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chipKIT® Cores and IDEs

⚫ chipKIT core: How to Install in Arduino® IDE

http://chipkit.net/wiki/index.php?title=ChipKIT_core

⚫ UECIDE

http://uecide.org

⚫ Others:

⚫ PlatformIO – http://platformio.org

⚫ Visual Micro – http://www.visualmicro.com

⚫ EmbedXcode – http://embedxcode.weebly.com

⚫ MPLAB X® IDE

http://www.microchip.com/mplabx

http://chipkit.net/wiki/index.php?title=ChipKIT_core
http://uecide.org/
http://platformio.org/
http://www.visualmicro.com/
http://embedxcode.weebly.com/
http://www.microchip.com/mplabx
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More chipKIT® Boards

chipKIT Pro

MX7

chipKIT MAX32

chipKIT DP32

chipKIT Wi•FIRE
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chipKIT® uC32 Board

⚫ Microchip PIC32MX340F512H

⚫ 80 MHz 32-bit MIPS

⚫ 512K Flash

⚫ 32K SRAM

⚫ Arduino® Uno form factor

⚫ 42 available I/O pins

⚫ Two user LEDs

⚫ 12 analog inputs 

⚫ 75 mA typical operating current 

⚫ 20V input voltage (maximum) 

⚫ 0V to 3.3V analog input voltage range 

⚫ +/-18 mA DC current per pin 
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Arduino® Uno

⚫ ATmega328

⚫ 32K flash, 2K RAM, 1K EEPROM

⚫ 22 I/O pins

⚫ 1 UART

⚫ 1 SPI

⚫ 1 I2C

⚫ 6 10-bit A/D inputs

⚫ 6 output compare/PWMs
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chipKIT® Max32

⚫ PIC32MX795F512L

⚫ 512K flash, 128K RAM

⚫ 83 I/O pins

⚫ 4 UARTs, 1 SPI, 2 I2Cs

⚫ 16 10-bit A/D inputs

⚫ 5 output compare/PWMs

⚫ USB 2.0 OTG controller

⚫ 10/100 Ethernet MAC

⚫ Dual CAN controllers
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Arduino® Mega 2560

⚫ ATmega2560

⚫ 256K flash, 8K RAM, 4K 

EEPROM

⚫ 70 I/O pins

⚫ 4 UARTs

⚫ 1 SPI

⚫ 1 I2C

⚫ 16 10-bit A/D inputs

⚫ 16 output 

compare/PWMs

⚫ 16 pins left 

unconnected
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chipKIT® DP32 Board

⚫ Microchip PIC32MX250F128B

⚫ 40/50 MHz 32-bit MIPS

⚫ 128K Flash

⚫ 32K SRAM

⚫ 19 available I/O pins

⚫ Four LEDs, two push-buttons

⚫ 9 analog inputs

⚫ Potentiometer

⚫ Wire-wrap prototype area

⚫ Provision for an SPI EEPROM and an analog temperature 

sensor

⚫ Mounting Hole compatible with Hammond 1591XXSSBK project 

box
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chipKIT® Fubarino® Mini

⚫ PIC32MX250F128D-50I/ML

⚫ 48 MHz operation

⚫ 128K flash

⚫ 32K RAM

⚫ DIP form factor

⚫ Max 33 I/O pins (normally 27)

⚫ Pads for 32 kHz crystal

⚫ Comes with headers (not installed) for easy mounting on a 

breadboard

⚫ Two buttons: RESET for resetting the board, and PRG for 

getting into bootloader mode and user application use
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chipKIT® Fubarino® SD

⚫ PIC32MX795F512H

⚫ 80 MHz operation

⚫ 512K Flash

⚫ 128K RAM

⚫ DIP form factor

⚫ uSD card connector

⚫ 45 available I/Os

⚫ 15 analog inputs

⚫ 2 UARTs

⚫ Comes with headers (not installed) for easy mounting on a 

breadboard

⚫ Two buttons: RESET for resetting the board, and PRG for 

getting into bootloader mode and user application use
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chipKIT® WF32 Board

⚫ Microchip PIC32MX695F512L

⚫ 80 MHz 32-bit MIPS

⚫ 512K Flash

⚫ 128K SRAM

⚫ 802.11g Wi-Fi®, MRF24WG0MA

⚫ USB Host/Device

⚫ uSD card connector

⚫ Uno32 shield compatible

⚫ 42 available I/O pins

⚫ Four LEDs, 2 Push buttons

⚫ Potentiometer

⚫ 12 analog inputs

⚫ Switching power supply
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chipKIT® Wi-FIRE® Board

⚫ PIC32MZ MCU w/ 2 MB Flash, 512K RAM

⚫ 200 MHz 32-bit MIPS core

⚫ Four 64-bit accumulators

⚫ Floating Point Unit

⚫ MRF24WG0MA Wi-Fi® module

⚫ Micro SD card slot

• 50 MHz SPI ports

• USB 2.0 Full-Speed / Hi-Speed controller 

• 43 available I/O pins with on-board user interfaces:

• 4 LEDs, 2 Buttons, 1 Potentiometer
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chipKIT® PGM Programmer

⚫ Provides in-system programming and debugging for 

Microchip PIC® MCU-based microcontroller boards

⚫ Intended for use with chipKIT boards

⚫ Works with the MPLAB® IDE and MPLAB IPE



68Webinar – Easy to install and Easy-to-use Arduino® Compatible chipKIT® Platform for Beginners (Dec 6, 2018)

chipKIT® Pro MX4 Board

⚫ PIC32MX460F512L

⚫ 80 MHz operation

⚫ 512K flash memory

⚫ 32K RAM memory

⚫ 74 available I/O pins, 9 Pmods, 8 servo connectors, 

2 push buttons, 4 LEDs

⚫ 2 UARTs, 2 SPIs, 2 I2Cs

⚫ 5 output compare, PWMs

⚫ 14 10-bit A/D inputs

⚫ MPLAB® IDE compatible 

licensed debugger
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chipKIT® Pro MX7 Board

⚫ PIC32MX795F512L

⚫ 80 MHz operation

⚫ 512K flash

⚫ 128K RAM

⚫ 64 available I/O pins

⚫ 6 Pmod connectors

⚫ 10/100 Ethernet, 2 CANs, USB 2.0 OTG Host/Device

⚫ 2 UARTs, 3 SPIs, 2 I2Cs

⚫ 5 output compare/PWMs

⚫ 12 10-bit analog inputs

⚫ MPLAB® IDE compatible licensed debugger
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chipKIT® Basic I/O Shield

⚫ Uno32 form factor

⚫ 128x32 OLED display

⚫ Four buttons

⚫ Four slide switches

⚫ Eight LEDs

⚫ Four open drain FETs

⚫ I2C EEPROM

⚫ I2C temp sensor

⚫ Potentiometer
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chipKIT® Wi-Fi® Shield 

⚫ IEEE 802.11b-compliant RF transceiver

⚫ Serialized unique MAC address

⚫ 1 and 2 Mbps data rates

⚫ IEEE 802.11b/g/n-compatible

⚫ Integrated PCB antenna

⚫ Range: up to 400m (1300 ft.)

⚫ Radio regulation certification for the 

FCC, IC, ETSI, and ARIB

⚫ Wi-Fi certified (WFA ID: WFA7150)

⚫ Micro SD card connector

⚫ Four LEDs
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chipKIT® Network Shield

⚫ Expands I/O on Max32

⚫ USB Host and Device connectors

⚫ 10/100 Ethernet PHY and connector

⚫ Dual CAN transceivers and connectors

⚫ Dual I2C connectors

⚫ I2C EEPROM

⚫ 32 kHz oscillator

The Network Shield in combination with 

the Max32 provides access to all of the 

features of the PIC32MX795F512L
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chipKIT® Motor Shield

⚫ Two H-bridge DC motor channels

⚫ Quadrature encoder feedback 

inputs

⚫ Four RC servo outputs

⚫ Four low side N-FET outputs

⚫ I2C I/O expander with four LEDs, 

two push buttons, two jumpers

⚫ Fits Uno32 style shield connector 

footprint
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LEGAL NOTICE

SOFTWARE: 

You may use Microchip software exclusively with Microchip products.  Further, use of Microchip software is subject to the copyright notices, disclaimers, and any license terms accompanying 

such software, whether set forth at the install of each program or posted in a header or text file.  

Notwithstanding the above, certain components of software offered by Microchip and 3rd parties may be covered by “open source” software licenses – which include licenses that require that 

the distributor make the software available in source code format.  To the extent required by such open source software licenses, the terms of such license will govern. 

NOTICE & DISCLAIMER:  

These materials and accompanying information (including, for example, any software, and references to 3rd party companies and 3rd party websites) are for informational purposes only and 

provided “AS IS.”  Microchip assumes no responsibility for statements made by 3rd party companies, or materials or information that such 3rd parties may provide.

MICROCHIP DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS, IMPLIED, OR STATUTORY, INCLUDING ANY IMPLIED WARRANTIES OF NONINFRINGEMENT,

MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE.  IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY DIRECT OR INDIRECT, SPECIAL, PUNITIVE, 

INCIDENTAL, OR CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND RELATED TO THESE MATERIALS OR ACCOMPANYING INFORMATION PROVIDED TO 

YOU BY MICROCHIP OR OTHER THIRD PARTIES, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE POSSIBLITY OF SUCH DAMAGES OR THE DAMAGES ARE FORESEEABLE. 

PLEASE BE AWARE THAT IMPLEMENTATION OF INTELLECTUAL PROPERTY PRESENTED HERE MAY REQUIRE A LICENSE FROM THIRD PARTIES.

TRADEMARKS: 

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings, BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, 

KEELOQ, KEELOQ logo, Kleer, LANCheck, LINK MD, maXStylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip

Designer, QTouch, RightTouch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. 

and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks 

of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, BodyCom, chipKIT, chipKIT logo, CodeGuard, CryptoAuthentication, CryptoCompanion, 

CryptoController, dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial Programming, ICSP, Inter-Chip Connectivity, JitterBlocker, KleerNet, 

KleerNet logo, Mindi, MiWi, motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, 

PureSilicon, QMatrix, RightTouch logo, REAL ICE, Ripple Blocker, SAM-ICE, Serial Quad I/O, SMART-I.S., SQI, SuperSwitcher, SuperSwitcher II, Total Endurance, TSHARC, USBCheck, 

VariSense, ViewSpan, WiperLock, Wireless DNA, and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries. 

All other trademarks mentioned herein are property of their respective companies.
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